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Due to a number of factors—unavailability of 
Summit Place on the second Tuesday of December, 
no alternate location available, and the snowy weather 
conditions, it was decided to not schedule a meeting 
this month. 

So enjoy watching the beautiful first real snowfall 
from the comfort of your home. And plan on attending 
some informative meetings at TC/PC in 2013. 

  

January 8 Meeting—Hot Cider Social 
At our January meeting we will be serving hot cider and snacks 
and take time to get to know each other better. Come with some 

ideas for topics for meetings for the new year . 

http://www.tcpc.com
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Thank You! 

The Digital Viking 
 The Digital Viking is the official monthly publication of 

the Twin Cities PC User Group, an all-volunteer organization 

dedicated to users of IBM-compatible computers. Subscriptions 

are included in membership. We welcome articles and reviews 

from members. The Digital Viking is a copyrighted publication 

and reproduction of any material is expressly prohibited without 

permission. Exception: other User Groups may use material if 

unaltered and credited. 

 Disclaimer: All opinions are those of the authors and do 

not necessarily represent the opinions of the TC/PC, its Board of 

Directors, Officers, or newsletter staff. TC/PC does not endorse, 

rate, or otherwise officially comment on products available; 

therefore, readers are cautioned to rely on the opinions presented 

herein exclusively at their own risk. The Digital Viking, its 

contributors, and staff assume no liability for damages arising out 

of the publication or non-publication of any advertisement, 

article, or other item. All refunds in full or in partial, for advertis-

ing, membership or any other item shall be at the sole discretion 

of the Twin Cities PC User Group Board of Directors. 

 

Advertising 
Full page (7½ x 9½) $100.00 

Two-thirds page (7½ x 6) 80.00 

Half page (7½ x 4¾) 65.00 

One-third page (7½ x 3) 50.00 

Quarter page (3½ x 4¾) 40.00 

Member Bus. Card (2 x 3½) 10.00 

Multiple insertion discounts available. 

Contact Sharon Walbran at:: SQWalbran@yahoo.com 

Deadline for ad placement is the 1st of the month prior to publica-

tion. All rates are per issue and for digital or camera-ready ads. 

Typesetting and other services are extra and must be requested in 

advance of submission deadlines. 

Payment must accompany order unless other arrangements are 

made in advance. Place make checks payable to: Twin Cities PC 

User Group 

TC/PC 2011-2012 Board of Directors 
 

Meets second Thursday of each month at 7:00 PM. All members welcome to attend. 

Call Ross Held (612-386-3172) for meeting details. 

President —Jim Grotz jim.grotz@raymondjames.com 

Vice President —Curt Trout ctrout@troutreach.com 

Secretary - Sharon Walbran sqwalbran@yahoo.com 

Treasurer  - Sheri Trout strout@troutreach.com 

Membership - - Open Position - - 

Meeting Coordinator- - Open Position - -  

Newsletter Publisher Sharon Walbran 952-925-2726 SQWalbran@yahoo.com 

Web Master Jack Ungerleider jack@jacku.com  

Jeannine Sloan Ambassador for Friendship Village 

Ron Bruncati 612-377-7936 brunron@mtn.org 

Joel Hedland joelh@spacestar.net 

Jim Schlaeppi jschlaeppi@charter.net 

Lon Ortner 612-824-4946 csacomp@comcast.net 

Steve Kuhlmey   steve@kuhlmeysystems.com 

Gary Grau    oxygary2389@yahoo.com 

Ross Held    RHeld3745@aol.com 

David Van Dongen   davidvandongen@yahoo.com 
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Product previews 
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Monthly Newsletter 

 

Discounts on products 

and services 

 

Contests and prizes 

Business Member 

Benefits 

 
All of the above PLUS: 

 

FREE ½ page ad on  

payment of each renewal 

 

20% discount on all ads 

Placed in the Digital 

Viking Newsletter 

 

Up to 5 newsletters mailed to 

your site 

(only a nominal cost for each 

additional 5 mailed) 

Newsletter Staff 
Editor Sharon Walbran 

Contributors: 

Jeannine Sloan 
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Last Month’s Meeting: Online Selling with Anne Simpson 
By Sharon Walbran, sqwalbran@yahoo.com 

As always, Anne Simpson was full of stories, tips, and insights into the world of online selling at 
our November meeting.  

Anne continues to promote the advantages of setting up your own store on eCrater. She says 
they have made it so easy for the seller to get started and she took us through some of the helpful 
information the site provides to demonstrate. Given that the cost of setting up a store is free and the 
payment options are much broader—Google Checkout, credit card, etc.—than eBay, which only 
allows you to use PayPal, because eBay owns PayPal, eCrater is the way to go. She recommended 
choosing a name for your store that falls in the beginning of the alphabet so that your store’s name 
will appear early in the list. Also, she suggested that you not make the store active until you have a 
decent inventory, somewhere between 50 and 100 items. She walked us through the steps to set up 
a store but keep it inactive. Before even setting up a store on eCrater she recommends clicking the 
Community link at the upper right of the eCrater page and reading the topic: “Store Set Up: Please 
read this before you ask questions.” 

She watches trends on all the online selling and auction sites and has made changes in her 
choice of inventory as a result. Whereas a year ago cookbooks were the largest part of her inventory 
she has found that no one buys cookbooks much any more except for sentimental reasons, because 
there are so many recipes available online. So she has quit buying cookbooks from estate sales and 
garage sales. Her sales of uncut sewing patterns for retro fashions are still good sellers and she has 
a substantial inventory of those. A “hot” item this time of year is the ugly Christmas sweater. There 
are now often contests at office Christmas parties across the country to give prizes to the ugliest 
Christmas sweater. She scours thrift shops to find decorated Christmas sweaters at bargain prices 
and has had success selling them at a substantial markup. She continues to sell gently worn t-shirts 
that she picks up at thrift stores and garage sales. Again she keeps a constant eye on what is selling 
for premium prices on eBay. She has had a couple of winners in retro t-shirts with 3-D images that 
have sold at a premium. 

She sets her prices based on her thorough research of similar products on eBay and eCrater. 
She does not try to jack up the price through high shipping and handling costs. More recently she 
has expanded the geographic areas she will sell and send to which has added to her market but not 
without some of the trials and tribulations of communicating with non-English speakers and the 
hassles of mailing outside the U.S. 

Thanks, Anne, for an eye-opening presentation. 
 
Go to Page 1 
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Create a Building Block in Word 2007 or 2010 
By Nancy DeMarte, Columnist, Office Talk, Sarasota PCUG, Inc., FL, October 2011 issue, 
Sarasota PC Monitor, www.spcug.org, ndemarte (at) Verizon.net 

If you create many documents in Word, you may find that you often include portions of text with 
similar content or format. For example, when preparing to submit SPCUG classes each month to 
the Monitor, I always include a list of the details: dates, day, time, location, instructor, and 
instructor’s email address. As I learned more about Word 2007, I realized I could set up a skeleton 
format for these class postings and save it as a “building block” (aka Quick Part) in Word. When I 
needed to prepare a new class posting, all I had to do was insert this building block into a document 
after the class description and enter the specific details, saving me the hassle of recreating the 
format. New in Word 2007, building blocks are related to templates except they are bits of text, 
rather than a whole document. For user convenience, a complete set of pre-formatted building 
blocks is listed on the Insert tab in the Text group under “Quick Parts.” Click the Building Block 
organizer to find pre-formatted text boxes, headers and footers, cover pages, page numbers, and 
more. Many of these building block galleries are also available under their own icons throughout 
Word. The Building Block organizer, however, includes all the categories in one place. You can 
insert any one of these blocks into a document or template by opening the document, placing the 
cursor where the block belongs, clicking the Insert tab, then Quick Parts, Building Block organizer, 
and the building block you want.  If that sequence seems too cumbersome, you can add the 
Building block organizer to the Quick Access menu. Right click the organizer title and select “Add to 
Quick Access toolbar.” 

Creating your own building blocks is easy and can save you lots of repetitive typing. The first 
step is to create a piece of formatted content. Let’s use the example of a logo which could be used 
in a letterhead, business card, and other documents. Since building blocks may contain many types 
of content, such as lines, images, drawings, and tables, as well as text, I created one using a table 
with text and a piece of clip art from the Word program. Here’s how it looks: 

 

   My next step was saving the building block. I selected 
the logo, clicked the Insert tab, then Quick Parts, and 
chose “Save selection to Quick Parts gallery.” This action 
opened the “Create New Building Block” dialog box, where 
I gave my block a Name, OTS logo. In the Gallery area, I 
left it labeled ‘Quick Parts’ because it didn’t fit into any of 

the existing galleries.  Under Category, I created a new one called Nancy, which let me group all my 
custom building blocks together for easier access. I skipped Description, although if I had I added 
one, it would have become the Screen Tip for the block. I left the Save In and Options boxes as 
they were and clicked OK to save my changes. 

Now it was time to try adding my new building block to a document. I opened a blank 
document and double-clicked about half way down the page to position the cursor there. Then I 
clicked the Quick Parts icon on the Insert tab, which showed previews of my last three custom 
building blocks. I clicked OTS logo and it appeared in the document where my cursor had been. 
Had the block not been visible as a preview, I would have clicked Building Block organizer and 
scrolled to Quick Parts under the Gallery column to locate it.  

Next I decided to change the font in the logo heading. I knew that any building block can be 
modified in a document without changing the version stored in the Building Block organizer. I 
changed the font of oTs from Goudy Stout to Bodoni MT black.  As an experiment, I saved the 
modified version to the Quick Parts gallery with the same name and properties as the first version to 

http://www.spcug.org
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see if it would overwrite the original. I was surprised to find that it did not. I ended up with two 
different versions with the same name. I decided it is necessary either to delete a first version before 
saving a second or give the second version a different name. Finally, since the logo block was only 
for illustration purposes, I decided to delete it. I simply opened the Building Block organizer, scrolled 
to and selected OTS logo, and clicked Delete. 

My own collection of custom building blocks includes a footer which includes my name, page 
number and current date; a copyright sign with my name; the SPCUG class detail list; and a 
personal logo I use as a letterhead. I do, however, often select from the galleries of pre-formatted 
building blocks located on almost every tab of Word 2007; for example, watermarks on the Page 
Layout tab, cover pages and text boxes on the Insert tab, or Table of Contents and Bibliographies on 
the References tab. More building blocks are available at www.office.microsoft.com. 

The more I customize my Word 2007 program, the easier tasks become. Creating custom Building Blocks is one 

more way to make Word 2007/10 my own.Go to Page 1 

Turn Your PC into a 3-D Game Machine 
By Vinny LaBash, Regular Columnist, Sarasota PCUG, Florida, October 2011 issue, Sarasota 
Monitor, www.spcug.org, labash (at) spcug.org 

3-D has been around for almost as long as photography.  The general public’s first major 
exposure to 3-D was the 1952 motion picture Bwana Devil.  It wasn’t the first 3-D movie, but it was 
the first to be shot in color and receive wide exposure.  The film didn’t win any awards, but the 
novelty of 3-D was a hit with big screen fans.  People became enamored with the illusion of depth for 
several years, but the thrill eventually faded, and 3-D was essentially gone from movies by 1960. 

3-D was by no means dead; it bounced around development labs for years until it was combined 
with wide screen technology and ultimately merged with the incredible IMAX experience.  You’re not 
going to get IMAX on your PC, but you can get a solid 3-D effect in most of your games with a little 
effort and small expense.  It might be fun too. 

Several weeks ago I received an interesting email from Roy R. who is well aware of my fondness 
toward high end games.  He told me about a web site that claimed to turn a PC into a platform that 
could display most games in 3-D even if they were designed for 2-D. 

Since the process appeared both relatively uncomplicated and inexpensive, the only thing to do 
was to see if it really worked.  The first thing was to go on Amazon and eBay and search for a pair of 
two color 3-D glasses.  They can be red/blue or yellow/blue.  You could probably make a pair 
yourself with colored cellophane.  A few minutes of searching came up with an acceptable pair of 
glasses for $2.00.  For that amount of money I almost didn’t care if they worked or not.  Whatever 
the outcome, it certainly beat spending $200 for a 3-D hardware accelerator, that much or more for a 
3-D monitor, and up to $200 for a pair of 3-D shutter glasses. 

The next step is to go to http://iz3d.com.  From there, download the free driver for their unique 3-
D monitor.  Here’s how it’s done. 
 
1. From the iz3d.com home page, click the Get Software page. 
2. From the dropdown menu, select Anaglyph. 
3. When the download screen appears, select the Current version Download button. 
4. After the software has been downloaded to your system, choose RUN to install the program. 
5. Follow the instructions on the dialog boxes or simply select the defaults. 
6. On the setup dialog box be sure to check the Run Control Center box.  Accept whatever 
defaults the process offers, and then click Finish. 
7. The Direct X dialog box will appear.  In the Output section select Anaglyph (free) and the option 

http://www.office.microsoft.com
http://www.spcug.org
http://iz3d.com/
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matching the 3-D glasses you have.  Click Apply. 
8. Examine the selections under Direct X in the left side of the dialog box. 
If you know what you’re doing, change whatever is appropriate, otherwise close down the 
dialog box by clicking on the red X in the top right corner. 
 
Install the driver on your machine. 
1. Close any open applications or browser sessions. 
2. Go to your Downloads folder and look for a file named iZ3DDriverSetup.1.12(4016).EXE.  If 
the numbers at the end of the file name are different, don’t worry about it.  All it means is that 
the driver has been updated since I wrote this. 
3. Double click on the file name to begin the installation process. 
4. You may get a Security Warning dialog box stating that the publisher could not be verified.  
Click the Run button. 
5. The Account Control dialog box may also make an appearance.  Give permission to 
continue. 
6. You will get several more dialog boxes.  Accept the defaults to continue. 
7. On the Select Destination Location dialog box either accept the default location for the 
installation files or choose another location.  Click Next. 
8. On the Select Components dialog box, choose Full Installation from the drop down menu. 
9. Click Next on the Select Start Menu dialog box. 
10. Click Install on the Ready to Install dialog box. 
11. Accept the defaults on any dialog boxes that may appear. 
12. Click Finish when the installation is complete. 
13.  On the DirectX dialog box select the Anaglyph (free) and Red/Cyan or Yellow/Blue 
depending on what kind of 3-D glasses you have. 
14.  Click Apply. 
Close out the dialog box by clicking on the red X in the upper right corner of the dialog box. 

 
Load any of your DirectX games and you will see a menu that will walk you through the 

steps to initialize the 3-D settings of the game.  You may have to shift the focus by holding 
down the Shift key and pressing the + or – key on the numeric keypad.  There are directions in 
the menu that refer to the “Num” key.  This is not the Num Lock key, but a reference that the 
instruction refers to the numeric keypad. 

The process worked with Mass Effect and Mass Effect 2, Call of Duty, Left for Dead, and 
World of Warcraft, an online game.  I couldn’t get it to work with Fallout New Vegas, so there’s 
no guarantee it will work with all of your games, but for $2 it’s certainly worth a try. 

3-D technology has changed and improved considerably over the years, but one thing 

remains constant.  3-D glasses still make you look like a dork. 

 
Go to Page 1 
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  By Jeannine Sloan 

Sharing eBooks 
eBook Exchange™ is the primary lending and borrowing marketplace for Kindle™ and Nook™ ebooks. 
Once you've read an ebook, put that purchase to work rather than letting it stagnate in your e-reader's 
archives. http://www.ebookexchange.com/index.php 
 

Bluetooth 
Bluetooth provides a secure way to connect and exchange information between devices such as faxes, 
mobile phones, telephones, laptops, personal computers, printers, Global Positioning System (GPS) 
receivers, digital cameras, and video game consoles. It was principally designed as a low-bandwidth 
technology. Most new equipment comes with Bluetooth built in. 

 
Shopping Help 
Gear shopping can be difficult at times. I'm trying to get all the research in one place for you, so you can 
save yourself time as you shop. http://thewirecutter.com/ A List of Great Technology 
What to buy & when to buy it. A recent study compared Decide to Consumer Reports. Find the best 
products and get price predictions backed by our guarantee. https://www.decide.com/  (free and fee 
based plans) 

 
Retailers Find Profits with Paperless Receipts 
A third, or 35%, of retailers offer digital receipts, and half of them do so at all their stores, according to a 
survey of 3,900 retailers released earlier this year by marketing firm Epsilon.  
http://www.9news.com/news/article/297833/344/Retailers-find-profits-with-paperless-receipts 

 
Keyboard Shortcuts in Windows 7/8 
Win+U Open the Ease of Access Center window Win+X Open the Windows Mobility Center 

 
Speed Up Browsing --Disable Flash 
In Internet Explorer click “Tools” – it’s the gear wheel icon in the upper right corner of the browser – and 
choose “Internet Options.” 
Click the Programs tab and click the “Manage add-ons” button. 
Scroll down in the right pane until you see “Shockwave Flash Object.” Select the entry, click the 
“Disable” button, and then click “Close.” 
Click “OK” and restart your browser. 
Reverse the instructions to restart Flash. 
Firefox users: Install the Adblock Plus and Flashblock extensions 
https://addons.mozilla.org/en-US/firefox/addon/adblock-plus/  
https://addons.mozilla.org/en-US/firefox/addon/flashblock/ 
 

Other good tips here: http://news.yahoo.com/blogs/upgrade-your-life/speed-browsing-161606208.html 

 

http://www.ebookexchange.com/index.php
https://www.decide.com/
http://www.9news.com/news/article/297833/344/Retailers-find-profits-with-paperless-receipts
https://addons.mozilla.org/en-US/firefox/addon/adblock-plus/
https://addons.mozilla.org/en-US/firefox/addon/flashblock/
http://news.yahoo.com/blogs/upgrade-your-life/speed-browsing-161606208.html
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Google’s Instant Street View 
Check out this new site by Google: http://www.qsview.com/ 

 

Identifying Trustworthy Websites 
To check whether a site is trustworthy go to http://www.siteadvisor.com/sites/ and fill the name of the site 
to be tested into the field provided. Siteadvisor.com is run by McAfee, a respected company. 

 

Where Does That Link Go 
In a web page HOVER the mouse pointer over the link. Note the address displayed at the bottom of the 
page. 

 

Tablet Reviews 
Not all of benchmark tests are available across all operating systems, but we do have a few that run on 
Apple's iOS, Google's Android, and Microsoft's Windows RT. We put two dozen of the latest tablets—
regardless of screen size—to the benchmark test to see how they compare. 
http://www.techhive.com/article/2014035/todays-best-performing-tablets.html#tk.nl_tablet 

 

Syncing an iPad Wirelessly 
If your equipment has iOS 5 or later software and you are using at least iTunes 10.5 then it’s possible to 
copy songs and photos from your computer to iPad without having to use the USB cable or iCloud.  
http://gadgetwise.blogs.nytimes.com/2012/11/20/qa-syncing-an-ipad-wirelessly/ 

 

Ransomware A Growing Menace, Says Symantec 
This type of scamware has jumped over the past year, both in number and variety, according to the 
security vendor. http://news.cnet.com/8301-1009_3-57548314-83/ 
Contributed by Ed Aubitz 

 

Scientists Find Cheaper Way to Ensure Internet Security 
The approach is based on quantum physics, which offers the ability to exchange information in a way 
that the act of eavesdropping on the communication would be immediately apparent. Read the New York 
Times article here: http://tinyurl.com/c6qt8n5 
 

Gmail Trick 
When you open an email message in Gmail and want to reply to just a portion of the message you can 
do that. Gmail has the handy feature where you can select a block of text, hit reply, and only that text is 
quoted in the response. (Try it in other email clients too.) Notice the sequence. 
1) Email message is in the reading pane. 2) Select a portion of the message. 3) Click the reply button. 

 
Security Hint for Mobile Devices 
Before installing apps on your device check the permissions and don’t install apps that require 
permission to send SMS messages. 

 
It’s In the Chip 
The user experience at a computer desktop is not governed so much by the brand of the computer as by 
the processor chip that is built into the guts of the machine. 

http://www.qsview.com/
http://www.siteadvisor.com/sites/
http://www.techhive.com/article/2014035/todays-best-performing-tablets.html#tk.nl_tablet
http://gadgetwise.blogs.nytimes.com/2012/11/20/qa-syncing-an-ipad-wirelessly/
http://news.cnet.com/8301-1009_3-57548314-83/
http://tinyurl.com/c6qt8n5
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“As the chip giant (Intel) puts its eggs in the mobile basket, the desktop is at risk, reports claim.” 
“Changes in the way Intel connects its processors to the circuit board may signal broad changes to 
the desktop PC as we know it today.” http://news.cnet.com/8301-1001_3-57555305-92/ 

 
Learn How to Disable the Geotagging Feature on Your Phone 
Most cell phones allow you to turn on/off the GPS location service. On my phone, which is not a 
smart phone, I found the setting under Menu|Settings & Tools|Phone Settings|Location. My only 
options are to leave the GPS on all the time or set it to activate when 911 is called. Check your 
phone or manual to locate the settings. 

 
RAM 
While it may seem counter-intuitive to those of us who remember our computers always being 
starved for RAM, high RAM usage means your RAM is being put to good use. Empty RAM is 
wasted RAM. 

 
Browser Encryption Strength 
When you click Internet Explorer's Tools icon and then About Internet Explorer, you'll see that the 
browser has a cipher strength of 256 bits — significantly fewer than the 1024 bits we now require 
for SSL certificates. The primary reason browsers use only 256-bit encryption is speed. A 2007 
TechNet blog states that 128-bit encryption was sufficient for the data we send and receive over 
the Net. So 256 bits should be a good balance between speed and security. Read the complete 
article here: 
http://windowssecrets.com/top-story/getting-a-handle-on-security-certificates/ 
 

SMS 
SMS stands for short message service. Simply put, it is a method of communication that sends 
text between cell phones, or from a PC or handheld to a cell phone. The "short" part refers to the 
maximum size of the text messages: 160 characters (letters, numbers or symbols in the Latin 
alphabet). For other alphabets, such as Chinese, the maximum SMS size is 70 characters. 
From How Stuff Works ezine 
 

Eradicate Fruit Flies Once and For All 
Make an effective fruit fly trap using just a bit of apple cider vinegar. Pour some in a glass, add a 
drop or two of dish soap to break the surface tension, and watch the little buggers start sinking to 
the bottom when they come over for their afternoon snack. http://lifehacker.com/5964785/ 
 

The Last Sounds You Ever Want to Hear Your Hard-Drive Make [Video] 
Listen to the sounds a hard drive makes when it is failing: http://www.howtogeek.com/130158/ 
 

Geolocation 
Typically, geolocation apps for smart phones do two things: They report your location to other 
users, and they associate real-world locations (such as restaurants and events) to your location. 
Apps that use geolocation include Foursquare, Gowalla, Brightkite, Loopt, Google Buzz, Ovi 
Lifecast, etc. Also any navigation service uses GPS/geolocation. Even Mozilla Firefox and Chrome 
web browsers on PCs can tell websites where you are located. 
Keeping your whereabouts hidden from other people defeats the purpose of geolocation, so you 
have to make sensible decisions about how widely you share your status and how carefully you 
guard your privacy settings. Good overview here: 

http://www.pcworld.com/article/192803/geolo.html        Go to Page 1 

http://news.cnet.com/8301-1001_3-57555305-92/
http://windowssecrets.com/top-story/getting-a-handle-on-security-certificates/
http://lifehacker.com/5964785/
http://www.howtogeek.com/130158/
http://www.pcworld.com/article/192803/geolo.html
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Special Interest Groups (SIGs) 
 

Most SIGs will meet at Edina Executive Plaza, Conference Room #102, 5200 Willson Road, Edina, MN 

 Confirm with a SIG group if they meet elsewhere. 

For more info contact the SIG Leader(s) listed here. 

 w Work phone    h Home phone   c Cell phone 

 * Meets at an alternate location 

Get SIG announcements! 

Link from www.tcpc.com 

Directions to Edina Executive Plaza 

for Systems on Saturday, Access,  

Word and Picture Perfect SIGs: Take 

Highway 100 to the 50th Street/Vernon 

exit. [If you have come from the north, 

cross back over Highway 100 to the 

east side.] Take the first right and go 

past Perkins [The golf course will be on 

your left.] and continue on the east 

frontage road (Willson Road) to the 

next building—5200 . There is ample 

parking in the building’s lot. 

Conference Room #102 is on 1st floor. 

Microsoft Access 
All levels. Presentations by expert develop-
ers within the group and by MS reps. 
Third Saturday 9:00 AM—Noon 
 
Steve Kuhlmey 952/934-8492 
 steve@kuhlmeysystems.com 
 

Microsoft Office 
Addresses the use, integration, and nuanc-
es of the Microsoft Office applications. 
Combined with Systems on Saturday 
Third Saturday of the Month  
 
Steve Kuhlmey 952/934-8492 
 steve@kuhlmeysystems.com 
 

Web Page Design 
Discussion and demonstration of HTML, 
web publishing software and page design. 
 
Second Tuesday @ 6:00-7:00 PM 
Every other month 
Right before the general meeting. 
 
Jack Ungerleider 612/418-3494 c 
 jack@jacku.com 

Microsoft Word for PC & Mac 
Any level user can be proficient and efficient 
in basics and advanced features of Word.. 
Combined with Systems on  
Third Saturday 9:00 AM—Noon 
 
Tom Ostertag 612/951-5520 w 
 651/488-9979 h 
Curt Trout 651/484-4569 h 
 ctrout@troutreach.com 
 

Systems on Saturday 
For all levels of computer challenges and any 
type of computer-related question. Incl. Q&A 
Meets 2nd & 3rd Saturdays 9:00 AM-Noon 
 
Curt Trout 651/484-4569 h 
 ctrout@troutreach.com 
 

Directions to Summit Place for General Meetings: 

Proceed to Eden Prairie Center Flying Cloud Drive . [Flying Cloud Drive runs along 

the West side of the Eden Prairie Center.]  Once you have driven past Eden Prairie 

Center (on the left) along Flying Cloud Drive you will come to a stop light at Prairie 

Center Drive.  The next intersection with a stop light and left turn lane is Fountain 

Place. Turn left at Fountain Place and go straight into the parking lot. Turn left again 

to the first covered entry way of Summit Place.  There is plenty of parking in the 

large parking lot in front of the first Summit Place covered entry way.  When you 

enter the door at the first covered entry way, ask to be directed to the Performance 

Room for the TC/PC meeting.  For a map of more detailed directions and info on 

Web SIG and Board meeting, check the TC/PC website. 

Board of Directors* 
All members are welcome! Call for location. 
Selected Saturday mornings 
 
Ross Held RHeld83745@aol.com 

 
 
Community Outreach* 
To request services or volunteer to help  
Contact: 
Ross Held RHeld83745@aol.com 
 

Linux on Saturday 
This is for the Linux newbie and those trying 
to come over from Microsoft to a different 
operating system. 
Second Saturday @ 9 AM-Noon 
 
Jack Ungerleider 612/418-3494 c 
 jack@jacku.com 
 

Picture Perfect 
Explore how to use your digital camera 
and learn how to use a variety of software 
for editing, organizing, and sharing images 
and video. 
Second Tuesday 6:00—7:00 PM 
Every other month 
Right before the general meeting 
Sharon Walbran    SQWalbran@yahoo.com 

Help yourself by helping others! 

Join the team & share your knowledge with others. 
Contact TC/PC at www.tcpc.com 

http://www.tcpc.com
http://www.tcpc.com
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Bluetooth - Not a dental diagnosis or a rare tooth problem. 
By Phil Sorrentino, President, Sarasota PCUG, Florida, October 2011 issue, Sarasota PC 
Monitor, www.spcug.org, president (at) spcug.org 

Bluetooth is the name given to a technology that uses short-range radio links, and is intended to 
replace the cable(s) connecting portable and/or fixed electronic devices. The vision is that it will 
allow for the replacement of the many propriety cables that connect one device to another with one 
universal radio link. Its boasts such key features as robustness, low complexity, low power and low 
cost, and it was designed to be operated in noisy frequency environments. 

Bluetooth is a communications standard for interconnecting electronic devices and is defined by 
the Bluetooth specification.  Bluetooth uses a form of data packet switching, a technology that is 
used to transmit digital data via a wireless communications link.  Bluetooth operates in the 
unlicensed ISM (Industrial, Scientific and Medical) 2.4GHz frequency band, and avoids interference 
from other signals by hopping to a new frequency after transmitting or receiving each packet.  Here 
is a little history, for you tech history buffs, to show how long Bluetooth has been around.  Work on 
Bluetooth was started in 1994 by two Ericsson Corporation engineers, and the Bluetooth 1.0 
specification was released May 1998. Version 1.0, with a data rate less than 1 Mb/s, had many 
problems, and manufacturers had difficulty making their products interoperable.  Bluetooth 2.0 was 
released November 2004 with a faster data transfer rate (approx. 2.1Mb/s).  And finally, Bluetooth 
3.0 was released April 2009 with a date rate of up to 24Mb/s with improvements and new features 
and is the current standard. 

Bluetooth uses a radio technology called frequency-hopping spread spectrum which chops up 
the data being sent and transmits chunks of it on up to 79 different frequencies. Bluetooth provides a 
way to connect and exchange information between devices such as Smartphones, laptops, personal 
computers, printers, Global Positioning System (GPS) receivers, digital cameras, video games, and 
others.  

Bluetooth is an open, wireless protocol for exchanging data over short distances between 
devices, creating a personal area network (PAN).  It was originally conceived as a wireless 
alternative to the old serial RS-232 data cables. Bluetooth is a network and thus can connect many 
devices, unlike RS-232 which was strictly serial point-to-point.  Bluetooth is primarily designed for 
low power consumption, with a short range.  Three ranges are defined in the standard, 100 meters 
(Class 1), 10 meters (Class 2), and 1 meter (Class 3).  Because Bluetooth devices use radio 
(broadcast) communications, they do not have to be in line of sight of each other.  Bluetooth makes 
it possible for these devices to communicate with each other and transfer information as long as 
they are in range. 

Both Bluetooth and Wi-Fi are examples of wireless technology that use the unlicensed 2.4GHz 
frequency spectrum.  Both have many applications in today's offices and homes such as: setting up 
networks, printing, connecting cooperating devices, and transferring data files among computers and 
smart devices. Wi-Fi is intended as a replacement for cabling for general local area network access 
in work areas.  Bluetooth is intended as a replacement for cabling among equipment in close 
proximity.  Wi-Fi is intended for use in equipment as a wireless local area network (WLAN).  
Bluetooth is intended for use as a smaller, personal area network (PAN). 

A PC uses a Bluetooth adapter in order to communicate with other Bluetooth devices.  While 
some desktop computers and most recent laptops come with a built-in Bluetooth adapter, others 
require an external adapter, usually in the form of a Bluetooth Dongle.  Bluetooth allows multiple 
devices to communicate with a computer over a single adapter.  For Microsoft Windows platforms, 
Windows XP Service Pack 2, Vista, and Windows 7 all have native support for Bluetooth. (Previous 
versions required users to install their Bluetooth adapter's own drivers, which were not directly 

http://www.spcug.org
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supported by Microsoft.)   
Some of the more common applications of Bluetooth are: 

 Wireless control of and communications between a mobile phone and a hands-free headset.  
This was one of the earliest applications. 

 Wireless communications with PC input and Output devices, the most common being the mouse, 
keyboard and printer. 

 Replacement of traditional wired serial communications used in: test equipment, GPS receivers, 
Medical equipment, bar code scanners, and traffic control devices. 

 Between game consoles such as Nintendo’s Wii, and Sony’s Playstation and their respective 
controllers. 

 Between video camera and remote monitor in Baby Monitor Systems. 
 Between Garage Door Opener Motor and Remote Garage Door Opener Controller. 

As you can see from this list, there are many reasons for computer devices to communicate with 
each other.  Here is a quick computer communications concept tutorial.  When any two devices 
need to communicate, they have to agree on a number of things before the communication can 
begin. The first point of agreement is physical: Will they talk over wires, or through some form of 
wireless signals? If they use wires, how many are required; one, two, eight, 25? Once the physical 
attributes are decided, additional questions arise, such as how much data will be sent at a time? For 
instance, serial ports send data 1 bit at a time, whil-e parallel ports send several bits at once.   And, 
how will they speak to each other? All of the devices in an electronic network need to know what the 
bits mean and whether the message they receive is the same message that was sent (i.e. 
checksums at the end of a message).  

This means developing a set of commands and responses commonly known as a Protocol. 
Bluetooth is essentially a networking standard that defines these two levels, physical and protocol. 
Bluetooth protocols simplify the discovery and setup of services between devices.  Before any 
communications can take place between two Bluetooth devices, they have to be paired.  In order to 
pair two Bluetooth wireless devices, a password (or PassKey) has to be exchanged between the two 
devices. A Passkey is a code shared by both Bluetooth devices, which proves that both users have 
agreed to pair with each other. 

A very brief description of Bluetooth pairing is as follows:  Bluetooth Device A looks for other 
Bluetooth devices in the area.  Bluetooth Device A finds Bluetooth Device B.  Bluetooth Device A 
prompts you, the user, to enter a password (or PassKey).  Bluetooth Device A sends the Passkey to 
Bluetooth Device B.  Bluetooth Device B sends the Passkey back to Bluetooth Device A.  At this 
point, Bluetooth Devices A and B are paired and able to exchange data.  Data between the devices 
will be accomplished wirelessly, over-the-air, a great boon to those who dislike the “rats nest” of 
wires typically found behind electronic devices. 

So, although dentists probably cringe when they hear the term, with all the computer devices you 

may have or are thinking of getting, there’s probably a Bluetooth in your future. 
 
Go to Page 1 
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Windows Live Photo Gallery  
by Lee Reynolds, Member, Boca Raton Computer Society, FL, October 2011 issue, Boca Bits, 
www.brcs.org, leetutor (at) exploringwindows.com 

Introduction 
For Windows 7, Microsoft has stopped furnishing the Windows Photo Gallery that was built into 
Windows Vista, and instead made a version of the program available from the Windows Live site. 
Windows Live Photo Gallery can also be installed in Windows Vista and Windows XP. By removing 
this component from the operating system, it is to be hoped that Microsoft will be able to provide 
updates and improvements in a much more timely manner. 
 
Download  
You can download the latest version of Windows Live Photo Gallery from here:  
http://www.windowslive.com/Desktop/PhotoGallery  
 
 
About Windows Live Photo Gallery  
With Windows Live Photo Gallery, you can manage all your photos, search for them,  import them 
from a camera or other removable media, order prints online, and publish them (upload to Windows 
Live Spaces, Flickr). 
 
When you import photos, they are automatically grouped by date and time. You can edit them to fix 
redeye, crop out unwanted sections, correct colors, and adjust the lighting, sharpness, etc. Any edit 
you make to your photos can be reverted later at any time. 
 
You can stitch several photos together to offer a "panoramic" view. You can also apply a treatment 
to color photos to convert them to black and white and shades of grey. 
 
The list of capabilities of the program goes on and on. 
 
For example, you can send photos by e-mail, burn them to a CD, and print them. 
 
You can add tags, ratings, and captions. Since Live Photo Gallery has the ability to automatically 
recognize faces, you can tag them with the names of the people in the photos and therefore be able 
to search by the people in your photos. 
 
You can resize, rotate, delete and rename the photos. 
 

There is QuickTime movie support if you have QuickTime 7 or later installed. 
 

Go to Page 1 
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You have just read an issue of The Digital Viking. 

 
Would you like to receive this delivered to your home or business each month? 

 
As a member of TC/PC, the Twin Cities Personal Computer Group, one of the benefits 

 is reading this monthly publication at www.tcpc.com.. 

 

As a member of TC/PC, you may attend any or all of the monthly Special Interest Group (SIG) meetings and be eligible for 

software drawings. The small membership fee also includes  

access to real-live people with answers via our helplines, discounts, and various other perks. 

 

Does membership in this group sound like a good way to increase your computer knowledge? 

 

It’s easy to do! Simply fill in the form below and mail it to the address shown. 

(If you use the form in this issue, you will receive an extra month for joining now.) 

 

 
Here’s the info for my TC/PC Membership: 
 

Full name_____________________________________________________ 

 

Company name________________________________________________ 

 

Address______________________________________________________ 

 

City_______________________________ State_________ Zip__________ 

 

Home  Business  Change address: Perm. Temp. ‘til ___________ 

 

Home phone____________________  Work phone____________________ 

 

Online address(es) _____________________________________________ 

 

Where did you hear about TC/PC? _________________________________ 
 
 I DO NOT want any of my information disclosed. 

 I DO NOT want to receive any mailings 

 
Administrative Use Only     Rec’d_____________________  Chk#_______________ 

 12/12 
I’m signing up for: 
 

 Individual/Family Membership ($18) 

 Business Membership ($100) 

 Student [ID required] ($20) 

If an existing member your # __________ 

Make checks payable to: 

Twin Cities PC User Group 
341 County Rd C2 W 
Roseville, MN 55113 
 

http://www.tcpc.com 
 

 Check #__________  Bill me 

 New member  Renewal  Prior member 

I’m interested in: 

 Training classes  Volunteering 

 Special Interest Groups: New User, Access, 
etc. 

List here: 
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FIRST CLASS MAIL 
341 County Rd C2 W 
Roseville, MN 55113 

November 8, 2011 • 7 PM 

General Meeting 
 

The Microsoft Store 
 

The Microsoft Store 
162 South Avenue 

Mall of America 

More info: www.tcpc.com 
P 

December 11, 2012  

No General Meeting 
 
 

More info: www.tcpc.com 
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